
Implementations master article for installing Manitou 2.0 on a single server. 

Before starting the Manitou Core installation, please verify all of the following are in place. All
exceptions to this will need to be recorded in the CRM for the project. 

Establish a connection to the customer, record in Bold Support Portal.
Google Chrome Browser installed and set as default browser
All Windows Updates Completed and the server restarted 

Turn off Windows Updates and set the schedule for Bold Support Hours
Installer files are copied to the machine 

Manitou Core Files
SQL Database install Files
SSMS install files

Verify Hard Drive Space is sized according to the SCD sent to customer
Verify with customer that server will NOT be renamed post-installation
Verify the server(s) have a Static IP address and not DHCP, note these in the CRM
Verify that all ICMPv4 traffic is allowed on all firewalls
Verify that all ICMPv4 pingis allowed on all firewalls
Verify that all machines can communicate across the network by Name and IP.
Disable UAC if using RDP

Leave UAC on if using GoToAssist. Restart server if a change is made
Verify that Installation User has Full Administration Rights to computer(s).
Verify that all transferred/downloaded files have NO NTFS permissions errors or blocks. 

1. Open Server manager
2. Click Manage then select Add Roles and Features. Alternatively, select Add Roles 

and Features from the Welcome Tile.
3. Select Role Based or Feature-Based Installation
4. Select the intended Server that needs features installed, then click Next. 
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5. Select Fax Server at the Server Roles page, select Add Features when prompted. 
6. Select the Web Server (IIS), select Add Features when prompted, then select Next.
7. At the Features Page expand .Net Framework 3.5 Features and check the box for 

.Net Framework 3.5.
8. Expand .Net Framework 4.X Features. Verify that .Net Framework 4.X, and 

ASP.NET 4.X are selected.
9. Expand WCF Services, verify that TCP Port Sharing is checked.

10. Scroll down to Telnet Client and check the box. 
11. Expand Windows PowerShell, verify that Windows Powershell X.X and Windows 

Powershell ISE are checked.
12. Select Next to proceed. 
13. Select Next at the Fax Server page.
14. Select Next at the Printer and Document Services page.
15. Leave Print Server selected when selecting role services, then select Next. 
16. Select Next at Web Server Role IIS page. 
17. At the Role Services page, leave the defaults boxes checked and add these additional

boxes under Web Server: 
 Common HTTP Features > HTTP Redirection
Performance > Dynamic Content Compression
 Security > Basic Authentication
Application Development > ASP.NET 3.5
Application Development > ASP.NET 4.X
Application Development > WebSocket Protocol

18. Expand the Management Tools and additionally check boxes for: 
IIS 6 Management  Compatability including all sub-boxes

19. Select Next, confirm the details of installation then select Install.

NOTE: If you are prompted for an alternate source path at the Confirm Installations 
page, follow the instructions Below.

1. Run gpedit.msc
2. expand Computer Configuration → Administrative Templates
3. Select System

4. Right click the setting Specify settings for optional component installation and 
component repair

.NET 3.5 Source File Fix



 and select Edit.
5. Set to Enabled.
6. Check the box that says Download repair content and optional features directly 

from Windows Update instead of Windows Server Update Services (WSUS) then
select OK.

7. Close the gpedit application.
8. Launch a command prompt as administrator
9. Type in and run the following command

DISM /enable-feature /featurename:NetFx3 /online /all
10. Return to the Add Roles and Features application and re-install any necessary roles or

features. 

 

SQL Installation
Planning/Prepping the Install



Before starting the install of SQL please outline the following in your own notes. Verify that the
customer is aware of these if needed.

Note the local or domain users that will be used for the SQL Windows Administration
accounts. 

It is recommended that a local MSSQL user is created on each machine to be used for
replication, however, if it is required to be a domain user, we will need to ensure that
the domain user is added to the local administrators group, and the password will not
expire.

Verify the drives the installation will include. It is highly recommended we have: 
1 OS drive
1 SQL drive
1 DatabaseCollector\Logs drive (Please note this is not for SQL logs, but for the
DatabaseCollector logs)

Determine where the SQL Installation Media is stored and keep a backup on hand for
possible future emergency installs. 

NOTE: This step is required for UL. All installation media will need to be on hand for
any emergency events requiring re-installation.

Verify Windows Updates have been completed.

 

The MSSQL user is used for replication between the SQL databases

1. Open a run dialog and run lusrmgr.msc

2. Open the Users folder and then right click within the user listing to select "New User..."
3. Create a MSSQL Username with the name and description of "Microsoft SQL Server"
4. Create a strong password for the account, recording it in the CRM under the name 

MSSQL.
5. Uncheck "User must change password at next logon"
6. Check "User cannot change password"
7. Check

Creating the MSSQL Account



 "Password never expires"

8. Select Create, then close the add user dialog.
9. Right-click on the created MSSQL user and select Properties.

10. Select the Member Of tab and then select Add...
11. Type in Administrators and select check names, select OK to confirm making this

account a local admin.
12. Select OK to close the MSSQL User Properties window and close out of the lusrmgr

application.

 

The following steps outline the standard installation steps for the SQL server instance

1. Start the SQL Server Installation Center, extracting files as necessary.
2. Under the Installation Tab select New SQL Server stand-alone installation or add 

features to an existing installation.
3. Leave Use Microsoft Update to check for updates box unchecked, select Next.
4. An error message may appear saying SQL Server setup could not search for updates,

select Next to proceed.
5. The Product Key page will be where the product key can be entered if not already

present. If applicable, enter the product key, then select Next. (Express does not require
a key)

6. Accept the License Terms, leaving the CEIP unchecked unless specified by the
customer, select Next.

7. On the feature selection page, DO NOT SELECT ALL FEATURES!

Installing the SQL Server Instance



1. Match features to the following (This can vary based on SQL version, however,
the minimum required pieces are Database Engine Services, and SQL
Replication)

8. Change the Instance Root, Shared Feature, and Shared feature (x86) directors to
match the SQL Data drive desired and/or specified, then select Next.

9. On the Instance Configuration screen, leave the instance as Default Instance 
(MSSQLSERVER), select Next. 

NOTE: A named instance is requirement it is outside of the typical Manitou
installation scope. This will need to be addressed with the project manager for this
project.

10. From the Server Configuration page, set the SQL Server Agent to Automatic startup.
11. Select the Collation tab and verify the Database Engine is set to 

SQL_Latin1_General_CP1_CI_AS, select Next.
12. From the Database Engine Configuration screen, set the Authentication Mode to 

Mixed Mode



13. Enter in a strong password for the SA Account and record it in the CRM under the
label SA.

14. For the Specify SQL Server administrators, select Add Current User
15. Select Add... type MSSQL then select Check Names, then select OK to confirm the

local MSSQL account. 
When adding the MSSQL user account it may bring a window that says Name Not
Found. If it appears change the location from Entire Directory to the machine SQL is
being installed on.
OPTIONAL: Select Add... then add any additional windows accounts that need
administrative access to SQL.

16. Select the Data Directories tab and make sure all directories are set to the intended
drive for SQL, select Next. 

NOTE: The log drive (if it exists) is not for the database log, it is intended for the
database collector installed at a later time.

17. Repeat steps 14-16 for Analysis Services, select Next. 
18. Verify the Install and Configure option is selected for Reporting Services, click Next.
19. At the Distributed Replay Controller Screen, select Add Current User... then Add...

user MSSQL as completed previously.
20. There will be a final verification window, review the options selected and select Install to

complete the Instance installation.
21. Verify that all features successfully installed at the installation complete screen.
22. If necessary, repeat these steps on all additional Database Servers.

Now that the SQL instance has been installed, it is necessary to install the SQL management tools
for the SQL version that was installed. Install the tools using the installer that was already copied
to the machine.

If the installation files for the SSMS were not already downloaded to the machine, follow these
instructions.

1. Open the SQL Server Installation Center if not already open.
2. From the Installation Tab, select Install SQL Server Management Tools
3. A website will open presenting links to Download SSMS
4. Download the latest SSMS General Availability version to the desktop
5. Once downloaded run the SSMS setup utility.
6. Select Install to begin.
7. Once the install is complete, a restart of the server is required.
8. If necessary, repeat these steps on all additional Database Servers.

Install SQL Server Management Tools

Final Configuration



1. Open SQL Server Configuration Manager (Start → Microsoft SQL Server 2016 → Sql
Server 2016 Configuration Manager) 

This must be opened in the same version the instance install was.

2. Login with the SA account using the credentials you made earlier.
3. From the SQL Server Configuration Manager, expand SQL Server Network 

Configuration and select Protocols for MSSQLSERVER
4. Right click on the Named Pipes protocol and select Properties.
5. Set Enabled to Yes, then select OK. 
6. Right click on the TCP/IP protocol and select properties.
7. Verify Enabled is set to Yes.
8. Verify Named Pipes and TCP/IP are Enabled.
9. Select the IP Addresses Tab, verify all IP Entries are Active, Enabled, and have TCP 

Port set to 1433.
10. Scroll down to IPAII, verify TCP Dynamic Ports is empty, and that the TCP Port is set

to 1433.
11. Select OK when complete.
12. Select SQL Server Services in the navigation pane, Restart all active SQL Services

then close the application.
13. Open SQL Server Management Studio (Start → Microsoft SQL Server Tools → Microsoft

SQL Server Management Studio)
14. Login with the SA account using the credentials you made earlier.
15. Right-click the root server node and select Properties.
16. Select the Memory tab, 
17. Specify the Maximum server memory (in MB) to be 60% of the total installed memory

of the server itself. 
NOTE: Standard practice is to reserve 4 GB for OS and 2 GB for Manitou services
at a minimum.

18. Select the Connections tab and verify the Allow remote connections to this server
 check box is checked.

19. Select the Advanced tab, under Miscellaneous, set the Max Text Replication Size
to 2147483647.

20. Select OK to apply all changes.
21. Close the application.

1. Open File explorer and navigate to the root directory of the specified data drive.
2. Create a New folder, name this folder SNAPSHOT
3. Right-click this folder and select Properties.
4. Select the Sharing tab, then click Share.
5. Type in MSSQL then select Add. If any other accounts were granted SQL access

previously, Add them also.

Creating the SNAPSHOT Folder



6. Change the permissions level to Read/Write for each additional user added, then select 
Share. 

7. If sharing was completed, select the Done, then select Close on the SNAPSHOT
Properties window. 

8. Repeat all steps on additional database servers.

This section will cover the installation of Manitou and its basic configuration for use. It is important
to note that the .exe applications should be installed, not .msi installers. This will allow all
necessary re-distributables, dependencies, and components to be installed before the core
software. If the files are not already copied to the machine, open Chrome and navigate to 
http://support.boldgroup.com/media/private/neoinstallpackage.zip

This installer will be ran on the first server installed. It should not exist on any other machines
unless it is a multi region server environment.

Installing Manitou

Technicians should use the .EXE applications to install Manitou. Do NOT using the .msi
versions.

Distributer Installation

http://support.boldgroup.com/media/private/neoinstallpackage.zip


1. Extract the Manitou Installation folder.
2. Once extraction is complete, open the extracted folder and navigate into the 

NeoInstallPackage/Installers folder, then launch Distributer_Setup.exe.
3. Agree to Install any additional dependencies if prompted.
4. After the additional dependencies are installed, The Bold Distributer Client installation

window will launch, select Next.
5. Install Manitou into the default location (OS Installation drive) location unless otherwise

specified. 
6. Verify Install is for Everyone is checked, then select Next.
7. Confirm the installation by selecting Next.
8. When prompted enter the Computer Name of the machine Distributer is being installed

on.
9. Select Yes to continue when prompted that the Distributer Service failed to contact.

10. Select Close when the installation completes.
11. In a File Browser, Navigate to the Manitou directory that was just installed (Default os 

C:\Program Files (x86)\Bold Technologies\Manitou)
12. Open the Distributer folder.
13. In a separate File Browser, navigate to NeoInstallPackage/Updates. Copy thecontents

of this folder into the open File Browser navigated to 
C:/ProgramFiles(x86)/Bold Technologies/Manitou/Distributer, approving access
and over-writing files if prompted.

This installer will be ran on all database servers and all servers where a Broker will run. It is
recommended that the Broker exists on the same server as the database.

1. Navigate into the NeoInstallPackage/Installers folder.
2. Run the ManitouServer_Setup.exe application.
3. Agree to Install any Dependencies.
4. The Manitou Server install window should appear, select Next. 
5. Accept the EULA if prompted.
6. Verify that Create Manitou Database and Disable Automatic Updates option boxes

are Checked.
7. Install Manitou into the default location (OS Installation drive) location unless otherwise

specified. 
8. Verify Install is for Everyone is checked, then select Next.
9. Confirm the installation by selecting Next.

10. If prompted, specify the Computer Name of the Distributer server 

Manitou Server Installation



This is the server name where the distributer was installed.
Port 7007 must be open in both directions between ALL servers and the
distributer machine.
The window may prompt behind the installer, check that the prompt is not hidden
behind the installation window if progress seems to have frozen.

11. When prompted, specify the Database server connection information: 
Server Name - location where the SQL Server Instance was installed.
Database Name - should be left as MANITOU
Database User - SA (unless otherwise specified, cannot be windows
authentication)
Database Password - password created during Instance installation (Should be
recorded in CRM)

12. Select the Test and wait for it complete, once successful select OK. 
13. When prompted, select the IP Addresses assigned to the machine in the drop downs,

then select OK. 
IP addresses must be static
IP addresses specified must be IPv4. Do not select IPv6 addresses even if they
exist.

14. Import any countries the customer will have customers in, then select OK. 
This step cannot be changed or repeated once submitted. The software and the
database must be removed and reinstalled to change submissions to this form.

15. Select Close to exit the completed installation.
16. Repeat these steps on all servers needed.
17. Once all servers are installed, add their information into CRM.

This installer will nee to be be run on all application servers.

1. Navigate into the NeoInstallPackage/Installers folder.
2. Run the ManitouClient_Setup.exe application.
3. Agree to Install any Dependencies.
4. The Manitou Client install window should appear, select Next. 
5. Check the box to install BOTH the Supervisor and Operator Workstations, then select 

Next. 
This is a requirement of the servers and may/will be different on individual
workstation installations.

6. Enter in all the Manitou Server Names that will contain an Application Server
(typically all DB servers), then select Next.

7. Install Manitou into the default location (OS Installation drive) location unless otherwise

Manitou Client Installation (legacy/VB)



specified. 
8. Verify Install is for Everyone is checked, then select Next.
9. Select Next to confirm installation.

10. Select Yes to continue if prompted that the Sentry Service failed to contact.
11. Select Close to exit the completed installation.
12. Repeat these steps on all servers needed.

This installer will typically be ran on all database or application servers. It is not uncommon to
have separate servers dedicated for FEPS. Project Managers and Kickoff calls should outline
individual setups.

1. Navigate into the NeoInstallPackage/Installers folder.
2. Run the FEP_Setup.exe application.
3. Agree to Install any Dependencies.
4. The Manitou FEP install window should appear, select Next. 
5. Check the box for Disable Automatic Updates then select Next.
6. Install Manitou into the default location (OS Installation drive) location unless otherwise

specified. 
7. Verify Install is for Everyone is checked, then select Next.
8. Select Next to confirm installation.
9. Select Close to exit the completed installation.

10. Repeat these steps on all servers needed.
11. If the servers that FEPs are installed on do are not recorded in CRM, record them now.

1. Navigate into the NeoInstallPackage/Installers folder.
2. Run the DBManager_Setup.exe application.
3. Agree to Install any Dependencies.
4. The Manitou DBManager install window should appear, select Next. 
5. Install Manitou into the default location (OS Installation drive) location unless otherwise

specified. 
6. Verify Install is for Everyone is checked, then select Next.
7. Select Next to confirm installation.
8. Select Close to exit the completed installation.
9. Repeat these steps on all servers needed conditional information: 

This should be on all database servers.
This should not be on any non database servers.
Only one DB Manager should be open at one time.

This typically is installed on the same server the Distributer Commander is installed on. Please

FEP Installation

DB Manager Installation

Bold License Manager Installation



verify that the machine it is installed on has a note in CRM's server listings as being the license
server. This should only exist on one server.

1. Navigate into the NeoInstallPackage/BoldLicenseManager_Setup folder.
2. Run the setup.exe application.
3. Agree to Install any Dependencies.
4. The Manitou License Manager install window should appear, select Next. 
5. Install Manitou into the default location (OS Installation drive) location unless otherwise

specified. 
6. Verify Install is for Everyone is checked, then select Next.
7. Select Next to confirm installation.
8. When prompted, enter in the configuration details for the license email provided to the

customer: 
Central Station ID - This is the account ID for the customer being installed.
Central Station Name - This is the Account Name in full as found in CRM.
POP3 Interval - 30

9. Select OK to proceed.
10. Select Close to exit the completed installation.

This must be installed on the same server as the Bold License Manager.

1. Navigate into the NeoInstallPackage/BoldLicenseClient_Setup folder.
2. Run the setup.exe application.
3. Agree to Install any Dependencies.
4. The Manitou License Client install window should appear, select Next. 
5. Install Manitou into the default location (OS Installation drive) location unless otherwise

specified. 
6. Verify Install is for Everyone is checked, then select Next.
7. Select Next to confirm installation.
8. Select Close to exit the completed installation.

It is necessary to verify some of the .ddl files that should be present in the Manitou Directory.

1. Open a File Browser and navigate to the Manitou directory, default 
C:/ProgramFiles(x86)/Bold Technologies/Manitou/

2. Verify the presence of the following .dll files: 
rscoree.dll - No longer needed in 1.6.2 and above, still required below
ManagedImports.dll 
RecordComms.dll - Only MediaGateWay, SnapReporter, and very old BoldNet

Bold License Client Installation

Verify .DLL Files



installations
dbnetlib.dll - Required for Server 2012 and up, located in InstallPackage

3. Verify these exist on other server if applicable.

After installing the Manitou software, it is important to complete the license before completing any
additional steps. The steps below detail how to configure the license client and then create a
license for a Manitou server.

1. Run the Bold License Client from the shortcut located on the desktop

2. Once open, select the Add button.
3. Enter in the following information: 

Machine Name - The Computer Name of the server to be licensed
System Type - The Role of the server to be licensed (Dropdown Menu)
Description - A description of the server type (Typically Manitou Server or MG
Server)
IP Address(es) - IP address of the server to be licensed 

Recommended IPv4 only
Can be retrieved automatically by selecting the arrow-world button. 

4. Select Save to store the information entered 
It is possible the configuration may present an error stating the config was updated
previous to the save. This means the information unfortunately will need to be
entered again to be saved. This will generally occur when it takes a large amount of
time entering in the system information.

5. Repeat steps on any additional servers to be licensed.

1. To apply a license, start the Bold License Client if not already running.
2. Right click on the server to be licensed and select Manual License Request.
3. Select Save to file, select the ... elipsies and choose a filename based on the server

name and save it to the desktop.
4. Select Save to place the license request on the desktop. 

Licensing Manitou

Configuring the Bold License Client

Generating a Licensing Request



If the license request fails, ensure the following. 
The Bold Monitor Service is running on the server to be licensed.
Port 7010 is open between the license client server and the server to be
licensed.
The Manitou directory containing the bold monitor service has the file
ManagedImports.dll

1. Connect to the LicenseMaster server (see Support/Implementation manager for details)
2. Transfer the created license request file to the desktop of the the LicenseMaster 

server.
3. Start the Bold License Master and login (See Support/Implementation manager for

details)
4. Upon startup of the Bold License Master, a configuration window will appear with mail

server settings. Do not change any of the settings and select OK.
5. Select File and then Import License Action.
6. Select the ellipsis next to the text entry field of File Name and then open the license

request located on the desktop.
7. Verify the Central Station Name and Machine Name to be imported, then select OK.
8. Navigate to and select the Central Station from the listing on the left
9. Right click on the license action created. (The Machine column will match the Host name

the request was created on)
10. Select Create License Key.
11. Fill in the License details to match the products purchased on the project proposal. 

This can be a large task to handle, please see the Support or Implementation
manager for assistance if needed.
The project proposal can be found under the Account's documentation in CRM.
Please see CRM documentation for more details.

12. Once all license options are filled, the license response can be saved, select Save to File.
Licenses should be created by default with 185 days expiration unless otherwise
specified.

13. Click the ellipsis next to the text entry field of File Name.
14. Specify the same name with a prefix or suffix added to to identify this is the response

file. 
EX: UPDCustIDSVR1, CustIDSVR1fin, etc...

15. Select Save and save the file to the desktop.

1. Transfer the generated license response files from the LicenseMaster Server to the

Authorizing a License Request with License Master

Installing Updated Licenses on Customer License Client 



Requesting Bold License Client Server's desktop.
2. Open the Bold License Client Server if not already open
3. Select File and Manual License Update...
4. Select the ellipsis next to the text entry field of File Name and then open the license

response located on the desktop.
5. Verify the Machine Name to be licensed, then select OK.
6. The license may take a few moments to apply, select OK  when the license applies

successfully.
7. Repeat the license steps above for any additional servers to be licensed. 

It is recommended all license requests, updates, and responses are done
simultaneously.

8. Delete all generated blc files from the License Master and Bold License Client servers'
desktop.

9. Once all servers are licensed, update the licensing spreadsheet to include the new
expiration date for the customer account installed. 

The licensing spreadsheet can be located via this link.
If the site does not exists on the licensing spreadsheet, add it. This is how support
tracks license expirations for renewal.
For access or questions regarding the licensing spreadsheet, please contact the
support manager.

Now that the installers for Manitou Core have been ran and the system is licensed, the software
and databases need to be updated and configured.

To continue with configuration, the server(s) will first need to be updated. This will not follow the
traditional update/upgrade steps as this is a new install. Please ensure the update files are in the
Distributer folder as outlined in the Distributer install instructions.

1. Open Distributer Commander. (Located on the desktop of the Distribution Server)
2. All servers installed should display in the Distributer commander. 

If any are not appearing ensure that the Distributer Client is running on each
server installed.
If the Distributer Client is not on a server installed, run the standalone distributer 
client installer.

3. Select all servers installed and right click on any of the servers selected, then select 
Send a Package.

4. In the Package Number field, fill in 2 then select Send Package.

Installing Updates Through Distributer 

Pushing Patches and Packages

https://boldgroup.sharepoint.com/:x:/r/sites/customercare/_layouts/15/Doc.aspx?sourcedoc={BCAAFBA1-DDE9-4F37-B289-E93B2A91DD67}&file=Licensing.xlsx&action=default&mobileredirect=true&web=1


5. After the package has been sent and applied it will appear under packages installed for
that machine.

The process of sending packages and patches can take up to a few minutes before
the patch or package will show as applied. If there is concern the package is not
being applied, the Distributer log can be monitored with the logger. Please see
Logger documentation for more details on how to monitor processes.

6. Select all servers installed and right click on any of the servers selected, then select 
Send a Package.

7. In the Package Number field, fill in 1 then select Send Package.
8. After Packages 2 and 1 show as applied, close the Distributer Commander
9. Restart the Bold Distributer service . 

1. Start Services.msc from a run dialog.
2. Locate the service name Bold Distributer, then Restart the service.
3. Close the Services window.

10. Once the service restarts, launch the Distributer Commander again.
11. Select all servers installed and right click on any of the servers selected, then select 

Send a Package.
12. In the Package Number field, fill in 9 then select Send Package and wait for the

installation to complete.
13. Select all servers installed and right click on any of the servers selected, then select 

Send a Package.
14. In the Package Number field, fill in 50 then select Send Package and wait for the

installation to complete.
15. If applicable, repeat this process for any additional services that need to be installed.
16. Select all servers and right click on the group, then select Update to Latest Patch.
17. Select Send Files to confirm the update push.
18. After the patch is applied it will show the Patch Number applied under the Patch No

column.
19. Close the Distributer Application  once the patch update completes. 

NOTE: If the Patch No does not update within a few moment try the following:
Restart the Distributer Client and try again.
Restart the Distributer Client Services and try again.
Check for additional errors in the logger.

DB Manager Configuration



In order to apply database updates the DB Manager will need to be configured, please follow these
steps before proceeding to the Database Update section.

1. Set the DB Manager to Always Run as Administrator.
Right click on the DB Manager application icon located on the desktop.
Select Properties
Select the Compatibility Tab, select the checkbox for Run as administrator,
then select OK
Select OK on the Properties window to save changes.

2. Start the DB Manager application located on the desktop.

3.  From the File Bar, File > New (or press Ctrl+N)
4. Specify the Database System Name (typically System 1)
5. Add all Databases that will be configured as part of the Manitou Core system. 

Server Name - The Computer Name of the database server
Use Windows Authentication - Uncheck this field
Login - Should be the SA account stored in CRM unless otherwise specified.
Password - The SA password
Database - Once all fields to the left are filled the drop down should be changed to 
MANITOU

If the dropdown does not populate, the connection string is failing and it is
likely the sa user or password is incorrect.
If the dropdown does not populate for remote servers, please ensure port 
1433 is open on the firewall.

Database Type - Should be left as Standard.

6. Once all Databases are entered, select File → Save (or press Ctrl+S)
7. Set the File name as DBMANConfig and save in the Bold Technologies folder

(Typically C:\Program Files (x86)\Bold Technologies)
8. Select the Replication tab.
9. Fill out the information with the MSSQL user and SNAPSHOT share created during the

SQL Install. 
Replication Agent Windows Account - MSSQL (other users may be specified)
Replication Agent Windows Password - MSSQL Password (stored in CRM)
Working Directory - SNAPSHOT
Manitou Customer Activity - Leave as default
Distributor Location - Leave Local Distributor checkbox 

Configuring the Database with DB Manager



unchecked

10. Save (Ctrl + S)changes made,  then close the Database Manager.
11. Repeat steps on all additional database servers.

Typically before applying a Database update a backup should be made, for the updates occurring
here, a backup is not needed.

1. Open the DB Manager
2. In the File menu, select File → Open (Or press Ctrl + O)
3. Open the DBMAN.dbsystem file created earlier (should be located in C:\Program Files 

(x86)\Bold Technologies)
4. Under the Activities tab, select Database Updates
5. From the Database dropdown, select the primary database installed. 
6. Verify the Database Update Type contains the correct version identifier, (2.0.0.0 for

this install) then select Apply.
7. Repeat Update steps for any additional database servers installed. 

Note: This can be done from the DB Manager on the primary server, it is not
necessary to run the DB Manager installed individual servers.

8. Select the Health Check tab on the under Activites.
9. From the Database dropdown, select the primary database server.

10. In the Schema field, select the magnifying glass.
11. Navigate to the Manitou Directory in program files.
12. Click into the Search Filter field and enter in SCHEMA
13. Select the most recent MANITOU_SCHEMA.xml file, then select Open. 

Applying Database Updates



If it is not in the Manitou Directory, it can be found in the patches within the 
Distributer folder.
Ensure the latest MANITOU_SCHEMA.xml file is being used to avoid critical issues
later in the install.

14. Once the Schema File is specified, select Check Database.
15. The health check will populate Database Modification Required table.
16. Click the column header to for Change Type, then click Select All.
17. Uncheck any boxes that have a change type of Remove
18. Once all Non-Removal Changes are selected, click Apply Changes and wait for the

health check to complete.
19. Select Check Database again to ensure all changes were applied.
20. Under Configure, select the Populate Tables tab. 
21. Select the the Primary database server from the Database dropdown.
22. If available, click the buttons for Repair Reverse Command tables as well as 

Populate City and Region Geo-Shape Tables.
23. Repeat Health Check steps for any additional database servers installed. 

Note: This can be done from the DB Manager on the primary server, it is not
necessary to run the DB Manager installed individual servers.

Now that all updates are complete, before any Manitou configuration is complete, replication
should be started. This ensures all changes within the Manitou software are replicated to other
servers.

1. Open the DB Manager if not already open.
2. Under Activities, select the Manage Replication tab.
3. Make the first Database Server that was installed primary.
4. Replication will build to all servers in the list. Once complete it should look similar to the

Starting Replication



following.

This step of the process is when the Manitou application will be started and the configured. Take
note to the configuration details as the steps must be followed completely for passing the
transition checklist for support.

1. Start the MSM Config application. (Start button,  > MSM Config)

2. Select Edit and enter in the following configuration details: 
Configuration Name - System 1 (each additional server should have
incremental system numbering. ex: System 2, System 3, etc...)
Computer - Comptuer Name of the server where the Manitou Server 
installer was installed.

Start and Configure Manitou
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Database Service - MSSQLSERVER
Backup Db Service - MSSQLSERVER
Server Name - Computer Name of the server where the Manitou Server 
installer was installed.
Database Name - MANITOU
Database User - Should be the SA account stored in CRM unless otherwise
specified.
Database Password - SA password

3. Select OK to save the configuration.
4. Launch Services.msc, then locate and restart the Bold Monitor Service.

This section covers the starting Manitou services

1. On the primary database server, open the MSM shortcut on the desktop.
2. Right click on the Logger and select Start
3. Right click on the Broker and select Start All
4. Verify all services start without issues
5. Start both the Operator and Supervisor Workstation Clients as administrator, ignore

the Operator client failure.
6. Log in to the Supervisor client (SWS) using the following credentials: 

2.0 and previous Default
Default User - BOLD
Default Pass - a

2.1 Default
Default User - BOLDTECH
Default Pass - b0ldt3ch! 

7. Accept the Software Use Agreement
8. Navigate to the workstation list, Maintenance → Workstations
9. Select the Edit Tab.

10. Change the Supervisor and Operator entries for the current machine to Protected 
Area under the Security Level dropdown, then select Save.

11. Switch back to the Operator Workstation client, and select Retry

Luanching MSM and Starting Manitou Services



.

12. Login to the Operator Workstation using the same credentials as the Supervisor
Workstation previously:

Default User - BOLD
Default Pass - a

13. Once logged in successfully, exit the Operator application. 

1. Navigate to the Manitou Distributer Directory, open the most recent patch folder and
launch the ManitouNEO_setup.exe

2. Select the checkbox for ManitouNeo installation.
3. Enter the following information: 

1. IIS Server - FQDN of the primary server
2. Sentry Service - FQDN of the primary server
3. Utility Service Port - 7020
4. Video Service Port - 7022
5. Timeout - 15

4. Open the Internet Information Services Manager (IIS)
5. Expand and navigate down to SERVERNAME > Sites, right click Default Website and

select Edit Bindings....
6. Select Add...
7. Using the dropdown select HTTPS.
8. Leave the default settings for IP address and Port.
9. In the Host Name field, enter the FQDN of the primary server.

10. Leave Require Server Name Identification box unchecked.
11. For SSL certificate, click the Select button.
12. Choose the appropriate SSL Certificate for this installation. 

Manitou NEO Installation



NOTE: If the customer does not have an SSL Certificate, a Self Signed can be
created for use.

1. in the IIS, navigate to the SERVERNAME, then locate the Server 
Certificates tool, then open the feature.

2. Open the feature, then select Create Self Signed Certificate from
the Actions Pane

3. Specify the name for the SSL Certificate. Using the *
ServerName*SSL is appropriate.

4. From the dropdown, select Web Hosting, then click OK. 

For users leveraging any web clients, it is necessary to install the Manitou Utility Service. 

1. From the Manitou\Distributer directory, locate and launch the most recent 
Manitou_Utility_Service_setup.exe

2. Leave the Ports at their default settings.
3. Accept the License Agreement, then select Next. 
4. Install Manitou Utility Services into the default location (OS Installation drive) location

unless otherwise specified. 
5. If prompted, approve the folder conflict by selecting Yes, then click Install. 
6. Repeat this process on ALL WORKSTATIONS AND SERVERS

1. Within the SWS, open configuration (Maintenance → Setup → Configuration)
2. Select the button for Edit mode.
3. From within the Application and Server navigation pane, highlight the FEP
4. Change the start status from disabled to Manual Start, then select Save.
5. Repeat these steps for any additional systems as needed.

Creating a Self Signed SSL Certificate

Installing the Manitou Utility Service

Adding a FEP to the System Configuration



6. Open the MSM, then Start the FEP application on the primary server.
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